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Software and System Tools and Applications

Standard Base Software
*Do not worry if you do not have all the software in the list.

Item | Software/Configuration/Plugin Word Latex Open Presentation
Editing Editing Document Editing
Editing

PDF EDITING

1 Adobe Acrobat Pro DC (if you have) v v v v

2 Barcode Font v 4 v
Crop and Dotting Script for Acrobat v 4 v
JACoWSetDot.js

4 Distiller Options v v v v
JACoW-12.joboptions

5 Enfocus PitStop Pro 2023 (30-day Trial) v v v v

6 Pitstop Media Box JACOW Media Box v v 4
SYSTEM TOOLS ETC

7 Font Liberation Mono (Liberation Mono - .ttf) v v v v

8 Compression Tools 7-Zip/WinRAR/WinZip v v v v
WEB BROWSERS

9 Firefox/Chrome/Edge v v v v
DOCUMENT EDITORS

10 Microsoft Office (preferable version 2021) v

11 LibreOffice Writer/FreeOffice/OpenOffice v

12 | Miktex v

13 | TeXStudio v

14 | Meld v

15 | Notepad++/WinEdit/EditPlus/GVIM v v v v
SLIDES TOOLS

16 | PowerPoint 365 v

17 Transparency Splitting (PPspliT) The zip file v
password is:“ppsplit”

18 Keynote (on mac systems) v

19 | Mac Fonts v
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Finding Software Online

Item Download Locations

1 https://github.com/JACoW-org/AcrobatPitStopTools Repository of addins
2 https://github.com/JACoW-org/AcrobatPitStopTools/tree/master/barcode font (Right click on Raw, Save
Link As)
3 https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoWSetDot.js (Right click on Raw, Save
Link As)
4 https://github.com/JACoW-org/AcrobatPitStopTools/blob/master/JACoW- Do not worry if you cannot
12.joboptions file it. You can get it at the
team meeting.
6 https://github.com/JACoW-
org/AcrobatPitStopTools/blob/master/JACoW%20Media%20Box.eal
7 https://www.freebestfonts.com/liberation-mono-font Download front site and
install on system
8 https://www.7-zip.org/ Download and Install
9 https://www.videolan.org/vic/ Download and Install
10 https://codecguide.com/download k-lite codec pack full.htm Download and Install
11 https://www.irfanview.com/64bit.htm Download and Install, also
install full plugins
12 https://camstudio.org/ Download and Install
13 | https://virtualdub.org/ Download and Install
14 | https://handbrake.fr Download and Install
15 https://miktex.org/, https://miktex.org/howto/install-miktex Download and Install
16 https://notepad-plus-plus.org/downloads/ Download and Install
17 http://www.maxonthenet.altervista.org/ppsplit.php See instructions on
https://www.jacow.org/JITM2016/ProcessingTransparenciesEmbeddingAnimations JACoW.org
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Configuration Requirements and Notes

System Notes for Font Install

Adobe Acrobat | Configure Acrobat, install script

Adobe Distiller Configure install JACOW-12.options, See below or Quick Guide

Word

Pitstop See Quick Guide

PowerPoint https://www.jacow.org/uploads/Editors/Slides Processing Manual V4
Quick Guide

1. Quick info for Acrobat/PitStop/PowerPoint script and tool
* JACoW-12.joboptions - JACoW JobOptions for Acrobat Distiller
* JACoW Media Box.eal - JACoOW Crop Media Box Action List for Enfocus PitStop
* JACoWSetDot.js - JACOW Acrobat extension to assign dots+ on paper
* SplitAnimations.ppa - PowerPoint add-in to split animation when creating PDF
* SplitAnimations.ppt - "Workspace" for developing the SplitAnimations.ppa PowerPoint add-in
* barcode_font - TrueType font needed by JACoWSetDot.js to create the barcode onto papers

2. Instructions on how to use these files.
JobOptions:

copy the file into the Acrobat | Settings folder or import via Distiller via the "Settings | Add Adobe
PDF Settings..." menu entry.

Media Box Action List:

Import from PitStop "Run Action List" menu item by right-clicking on the "Local" folder and then
choosing "Import/Export..."

JACoWSetDot.js

First, install the "fre3of9x.ttf" font into the computer. The exact procedure may vary from platform
to platform. On OSX a warning could be given - just ignore it and proceed with the installation.

Copy "JACoWSetDot.js" into the Acrobat JavaScript extensions folder.
Also, this path could change for different operating system and Acrobat versions.
For Windows 7 and Acrobat 9 it defaults to
C:\Program Files\Adobe\Acrobat 9.0\Acrobat\Javascripts
and for Mac OS X 10.9 and Acrobat 11 it defaults to
~/Library/Application Support/Adobe/Acrobat/11.0/JavaScripts

(The directory may not exist - create it manually).
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Also, remember to set the security option in Acrobat's preferences, otherwise the script won't
work. Go under Edit->Preferences->General->JavaScript and check the "Enable menu items
JavaScript execution privileges" option.

Moreover, in the "ldentity" tab be sure to have your (editor) name set,

REFERENCES:
- https://helpx.adobe.com/acrobat/kb/user-javascript-changes-10-1.html

- http://www.pdfscripting.com/public/111.cfm
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Software Configuration

Font Installatio

n

Install Fonts Barcode, and Liberation Mono. Right Click on each font and select install.

[7] AuTHORS fs] File
[7] Changelog ] File
[7] copvinG 53 File
+_ LiberationMono-Bold.ttf e TrueType for
+_ LiberationMono-Bolditalic.ttf 2 TrueType for
+_ LiberationMono-Italic.ttf z TrueType fon
+ LiberationMono-Re - TrueType fon
5] License.txt Eise Text Documi
[] ReaDME (e File
© Share with Skype
Install
& Install for all users
@ Share
View online
Version history
Always keep on this device
Free up space
7-Zip >
CRCSHA >
) Convert to Adobe PDF
) Convert to Adobe PDF and EMail
[&f Edit with Notepad++
EB Scan with Microsoft Defender...
Open with >
Give accessto >
o —
H “« ”
Or select all font and click “Install for all users.
M < | IPACJACOW Font
Home Share View
<« v 4 > ThisPC > Documents > JACoW Editor > IPAC JACoW Font v 0
A~
Name Date modified Type Size
s Quick access
B Desk 2 A barcode_font 0.L43010.0,24 DAY TewseTh ont file 8KB
eskto i -

i + | LiberationMon Preview font file 103 KB
¥ Downloads  # | \yationMoq Print ont file 116 KB
[£ Documents  # « Ihehani Install font file 121KB
=] Pictures # s LiberationMof ) Install for all users ont file 106 K8

A4 ~Zip >
AcrobatPitStopTool ) Convert to Adobe PDF
AcrobatPitStopTool [&f Edit with Notepad++
IPAC 22 IT Work & EditPlus
[ OneDrive EQ Scan with Microsoft Defender...
% Edit with Vim using tabpages
& OneDrive {#& Edit with single Vim
[ This PC |2 Share
& Network Give access to >
B9 Add to archive...
8 Add to "IPAC JACOW Font.rar
% Compress and email...
#%¥ Compress to "IPAC JACOW Font.rar” and email
Send to >
Cut
Copy
Sitems  5items selected 451 KB

L Search IPAC JACoW Font
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Adobe Acrobat DC Pro Configuration

1. Access Preferences Menu
Ctrl + K Access the Preference Menu

Adobe Acrobat Pro DC (64-bit)

File View E-Sign Certified PDF

H;

PitStop Pro  Window  PitStop Pro Dashboard Help

Eind

Advanced Search

Check Spelling
Protection

Preferences

Ctrl+F
Shift+Ctrl+F

mended tools for you

PDF

jacow-collaboration
PDF

T

B JACOW_LaTeX A4
[—l PDF

B JACOW.W10.A4

L POF
General... Ctrl+K
Enfocus PitStop Pro... Alt+Ctrl+K

Enfocus StatusCheck...

PDF [ create PDF
d images fast. Fix a Quickly turn Microsoft Office
p an image. and other files into PDFs.
Use Now
NAME

3 Script for Acrobat_Pitstop_PowerPoint Readme

document
PDF

Editor Copmputer Setup
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2. General Settings

Stop Acrobat from generating URLs links in distilled papers. (Uncheck “Create links from URLs”)

Preferences

Categories: Basic Tools

Commenting ingle-key accelerators to access tools

Documents
&t & images

Full
Make Hand tool read articles

[[] Make Hand tool use mouse-wheel zooming

Select As Default PDF Handler

Tell me if Adobe Acrobat is not my default PDF application

pixels/inch

Accessibility
Action Wizard [[] Make Select tool select images before text
Adobe Online Services Show quick actions on text selection
Catalog > S
Color Management [ Show online storage when opening files
Content Editing Show online storage when saving files
ConvertbompDE [C] Open PDFs from last session on Acrobat launch
Convert To PDF
Email Accounts Open documents as new tabs in the same window (requires relaunch)
Forms Prompt before closing multiple tabs
|denti
dentity View Starred files in Recent tab
Internet
JavaScript
Language
Measuring (2D) D Use fixe
Measuring (3D) x E B
Iv]
Measuring (Geo) Enable PDF thumbnail previews in Windows Explorer
Mult!medra asD Touch Mode: | Auto-Detect v
Multimedia (legacy)
Multimedia Trust (legacy) Scale for screen resolution (restart required): (@) Auto-Detect (O No Scaling
Reading
Reviewing
Search
Security
Security (Enh d|
Fcunty( nhanced) WA
Signatures
Spelling [JDo not show edit warnings
Tracker
Trust Manager
Units & Guides Messages from Adobe
Updater Show me messages when | launch Adobe Acrobat
Application Startup
[ Use only certified plug-ins Currently in Certified Mode:  No

Reset All Warnings
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3. Page Display

Display fonts using the fonts in the PDF not local fonts. (Uncheck “Use local fonts”)

Preferences

Categories:

Commenting
Documents
Full Screen

< Page Display )

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Security (Enhanced)
Signatures

c-

Default Layout and Zoom

Page Layout: | Automatic v Zoom: IAutomatic o I
Resolution

(O Use system setting: 96 pixels/inch (® Custom resolution: 110 % pixels/inch
Rendering

Smooth Text: | For Laptop/LCD screens v

[ Smooth line art Smooth images [J Use local fonts

[ Enhance thin lines [J Use page cache

Page Content and Information

[ Show large images [[J Use smooth zooming
[C] Show art, trim, & bleed boxes [ Show transparency grid
Use logical page numbers [J Always show document page size

Use Overprint Preview: | Only For PDF/X Files v Use Shift + Click For Multiple Selection with Output Preview

Default Transparency Blending Color Space: | Working RGB v

Reference XObjects View Mode

Show reference XObject targets: | Only PDF/X-5 compliant ones v

Location of referenced files: Browse for Location...

Cancel
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4.1 Content Editing
Make sure Adobe Acrobat displays this as they are. (Uncheck “Enable Artificial Bold/Italic Styles”)

Preferences X

Categories: Default Editors for 'Edit Object Tool'

Commenting ~
Documents -
Full Screen Image Editor...
General
Page Display
Page/Object Editor...
Accessibility
Action Wizard
Adobe Online Services
Catalog
ColorManag
Content Editing
2 1)

Reading Order

Left to Right, Top to Bottom  +

orver-Erom Font Options
Convert To PDF
Email Accounts

Forms — ]
Identity Default font for Add Text | Wingdings 3 v FontSize
Inteenet [ Enable Artificial Bold/ltalic Font Styles

JavaScript

Language

Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Fallback font for Editing | Wingdings 3 vi ®

4.2 Content Editing
While editing if you accidentally type changing text in the PDF you may not notice, by setting the
editing text and add text to Wingdings 36 font size it will be obvious immediately

Preferences

Categories: Default Editors for 'Edit Object Tool'

Commenting ~
Documents

Full Screen

General

Page Display

Image Editor...

Page/Object Editor...
Accessibility

Action Wizard
Adobe Online Services
Catalog

Reading Order

Left to Right, Top to Bottom v

= Font Options

Convert To PDF
Email Accounts

ck font for Editing | Wingdings 3 vl ®

F
o Default font for Add Text | Wingdings 3 | Fontsize
Identity
Internet [ Enable Artificial Bold/Italic Font Styles
JavaScript
Language

Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search
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5. Convert From PDF

Include all fonts during embedding. In the Encapsulated PostScript drop down menu “Font
inclusion” = Embedded and Referenced Fonts, Uncheck Convert TrueType to Type 1.
Preferences X

Categories: Converting From PDF
Commenting ~ ( Encapsulated PostScrip A PostScript level: 2 A
Documents Exce Binary: False
Full Screen H Preview: None
General )y P S lto:
Page Display PEG2000 < Font emitting: All fonts

/ PNG m
Accessibility PostScript Profife: Working CMYK
Action Wizard PowerPoint Presentatic Emit [CIDFontType2 as CIDFontType2: True
Adobe Online Services Rich Text Format Convrt TrueType to Type 1: False
Catalog Text (Accessible) Emit Lomments: False
Color Managem Text (Plain) Emit Malftones: False
C ith TIFF Emit Yransfer Functions: True

< Convert From PDF ) Word 97-2003 Docume Emit Undercolor removal: False
Word Document Overpfint: False
Email Accounts XML 1.0 Y Emit Rptness: True
Forms < 2 Color: Composite o
Identity “.
Interet
JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading
Reviewing
?earch o
oK Cancel

6. Identity

Place your name in the identity “Name” field which will be printed on the top of the page when you

print a dotted paper.

Preferences

Categories:

Commenting ~
Documents

Full Screen

General

Page Display

Accessibility

Action Wizard

Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF

Email Accounts
Forms

Internel

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Identity

Login Name: IIPAC_PC1

Title: l

Organization Name: I

Organizational Unit: I

Email Address: I

Your identity information is used

with comments, share, and digital signatures.

To change settings for Adobe online services, go to the Online Services preferences and click

Manage Account.

Cancel
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7. JavaScript

JavaScript > Enable Menu Items > Check Enable menu items JavaScript execution privileges.

Preferences

Categories:

Commenting
Documents
Full Screen
General
Page Display

Accessibility
Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

‘ JavaScript

Measui

g (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)

Multimedia Trust (legacy)

Reading
Reviewing
Search

8. Search

JavaScript

A [FEnable Acrobat JavaScript

JavaScript Security

[/ Enable global object securnity policy

JavaScript Debugger

[_JEnable JavaScript debugger after Acrobat is restarted

[T Enable interactive console

[ Show console on errors and messages

JavaScript Editor

(®) Use Acrobat JavaScript Editor

Font: | Courier New v Size:

(O Use external JavaScript editor

Configure the Acrobat search tool.

Preferences

Categories:

Commenting
Documents
Full Screen
General

Page Display

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

E——

Search
[“] Enable auto complete suggestions
Highlight all matches
[ Ignore Diacritics and Accents

Always show more options in advanced search

[ Show document title in search results

Maximum number of documents returned in Results: {500
Range of words for Proximity searches: 900

Fast Find

Fast Find makes future searches faster by storing information about Adobe PDF files that you use often.

Enable fast find
Maximum Cache Size: FBO— MB
Purge Cache Contents

]

Cancel

Cancel
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9. Units and Guides

Setup the gridline which will show you the margin rules on the page. These are turned on and off
using Ctrl + U

Preferences

Categories: Units

Action Wizard A Page & Ruler Units: Poinli\ 6
>

Adobe Online Services

Catalog ayout Grid
Color Management B

Content Editing Width between lines: (483 pt By,
Convert From PDF

Convert To PDF Height between lines: 680 pt =
Email Accounts ;

Forms Grid offset from left edge: |56 pt =

Identity
Internet Grid offset from top edge: |54 pt =
JavaScript

Language Subdivisions: |1 S
Measuring (2D) ) :
Measuring (3D) k Grid line color: ﬂ /

Measuring (Geo)
Multimedia & 3D Guides
Multimedia (legacy)
Multimedia Trust (legacy) CiRdecalog m
Reading
Reviewing Rulers
Search

Security

Security (Enhanced)
Signatures

Spelling

Tracker

< Units & Guides ) v

[ Show rulers when opening documents

OK Cancel
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10.1 Convert From/To PDF
Setup the PostScript/EPS to “JACoW 12” Template
Note: Before do this step must be setup the Adobe Acrobat Distiller DC first.

Preferences

Steps 1-6 lead to 7: Font emitting: All fonts

Categories:

Converting From PDF

3D & Multimedia
Accessibility

Action Wizard

Adobe Online Services
Catalog

Color Management
Content Editing

Convert To PDF B
Email Accounts

Forms

Identity

Internet

JavaScript

Language

Measuring (2D)
Measuring (3D)
Measuring (6eo)

2 Encapsulated PostScri a

Convert From PDF b 7 pj;

Excel Workbook
HTML

JPEG

JPEG2000

PDF/A

PDF/E

PDF/X

—p- PostScript

PowerPoint Presentati
Rich Text Format

Text (Accessible)
Text (Plain)

TIFF

Word 97-2003 Document

Word Document v
<

>

N

PostScript Tevel: 3
Binary: True
Pages: ALl

Font emitting: ALl fonts ——————

Transparency level: 100

Profile: Working RGB

Emit CIDFontType2 as CIDFontType2: True
Convert TrueType to Type 1: False
Emit Comments: True

Emit Halftones: False

Emit Transfer Functions: True
Emit Undercolor removal: False
Overprint: False

Emit Flatness: True

Color: Composite

Negative: False

Tranning: False

<

Multimedia (legacy) Edit Settings... 3

Multimedia Trust (legacy)

Readin

Review%ng Save As Settings

Search

Security i iption File: Device Independent

Sgcurity (Enhanced) Printer Description File: P Defaults

Slgnatures 0eNeral  —————— g General

Spelling dutput 6

}?3gteaanager Marks and Bleeds Settings

Units & Guides PostScript Options OASCI

Updater Color Management ; Postscript  Language Level 3

v @ Binary
/ Font Inclusion: |Embedded and Referenced/Fonts .
None
/ M Include CommentsEmbedded Fonts
£ Th ,Embeddgd and Referenced Fonts
= = Convert TrueTyp
Categories: Converting To PDF
S— EMF A : : : : - ;

3D & Multimedia HTML Click Edit Settings to view or edit settings for
Accessibility JPEG this file type.
Action Wizard JPEG2000

Adobe Online Services ; e |Microsoft 0ffice Exce
2p === Microsoft 0ffice Powe

Catalog

Color Management
Content Editing
Convert From PDF

2C == Microsoft Office Word

Microsoft 0ffice Proj
Microsoft Office Visi

Steps 1-6 to be repeated for MS Word, Excel,

PowerPoint.

Convert To PDF <1 Multimedia
Email Accounts PCX
Forms PNG
Identity PostScript/EPS
Internet Text
JavaScript TIFF
Language XPS
Measuring (2D) M
Measuring (3D) < > 3
Measuring (6eo) /
Multimedia (legacy) Edit Settings...
Multimedia Trust (legacy)
Reading Adobe PDF Settings for supportid documents X
Reviewing 4 %
Search e
Security Adobe PDF Settings: 9 [CEdit.:.
Sgcurity (Enhanced)
Signatures Adobe PDF Security: MNone v Edit...
Spelling
[Iracke CJAdd bookmarks to Adobe PDF file
Trust Manager
Units & Guides [JAdd links to Adobe PDF file
Updater [“IEnable accessibility and reflow

/ 5

0K

Cancel
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Preferences

Categories:

3D & Multimedia
Accessibility

Action Wizard

Adobe Online Services
Catalog

Color Management

Content Editing

Convert From PDF

Convert To PDF e 1
Email Accounts

Forms

Identity

Internet

JavaScript

Language

Measuring (2D)

Measuring (3D)

Measuring (Geo)
Multimedia (legacy)
Multimedia Trust (legacy)

Converting To PDF
Compuserve GIF a

HTML

JPEG

JPEG2000

Microsoft 0ffice Exce
Microsoft 0ffice Powe
Microsoft 0ffice Proj
Microsoft 0ffice Visi
Microsoft 0ffice Word
Multimedia

PCX

PNG

PostScript/Eps ~e=—————2
ex

TIFF

XPS <

< >

Click Edit Settings to view or edit settings for

this file type.

Edit Settings...

p— 3

Reading — &
Reviewing Adobe PDF Settings X
Search
Security
Security (Enhanced) Adobe PDF Settings: N Edit..
Signatures
Spelling Adobe PDF Security: None ay
Tracker
Trust Manager e
Updater
0K Cancel
10.2 Convert to PDF
Setup the PNG Grayscale and Color to High Quality
Categories: Converting To PDF
Commenting ~ Adobe Formats ~ Monochrome Compression: JBIG2 (Lossless)
Documents Autodesk AutoCAD Grayscale Compression: JPEG (Quality : Medium)
Full Screen BMP Color Compression: JPEG (Quality : Medium)
General Compuserve GIF RGB Policy: Preserve emb Adobe PDF Settings X
Page Display HTML Gray Policy: Off
. JPEG
Accessibility JPEG2000 Compression
Action Wizard Microsoft Office Excel Monochrome: | JBIG2 (Lossless) v
Adobe Online Services Microsoft Office Powe:
Catalog Microsoft Office Word
Color Management Multimedia
Content Editing >
o —— < PNG
o e Text v Color Management
Forms S = RGB:  Preserve embedded profiles v
Identity
Internet Edit Settings... Jot apphcable
JavaScript
Language Grayscale:  Off N
Measuring (2D)
Measuring (3D) t applicable
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy) 0@% Defaults Cancel
Multimedia Trust (legacy)
Reading
Reviewing
Search &
oK Cancel
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11. Full Screen

Configure the Full Screen.

Preferences

Categories:

Commenting

Docum
< Full Screen )
Page Display

Accessibility

Action Wizard
Adobe Online Services
Catalog

Color Management
Content Editing
Convert From PDF
Convert To PDF
Email Accounts
Forms

Identity

Internet

JavaScript
Language
Measuring (2D)
Measuring (3D)
Measuring (Geo)
Multimedia & 3D
Multimedia (legacy)
Multimedia Trust (legacy)
Reading

Reviewing

Search

Security

Full Screen Setup
Current document only
[AFill screen with one page at a time
[4] Alert when document requests full screen

Which itor to use:  This Moni v

Full Screen Navigation

[ Escape key exits
[] Show navigation bar

[ Left click to go forward one page; right click to go back one page

Loop after last page

[J Advance every IS seconds

Full Screen Appearance

Background color: [l

Mouse cursor:  Hidden After Delay v

Full Screen Transitions

[[] Disable all page transitions (e.g. auto-advance, slideshow, etc.)

Default transition: ~ No Transition v

Directior  [M Navigation controls direction

Cancel
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Copy Doting Script to the correct Location
Place Dotting Script into ....... Directory, note the directory will be named the same as the version of
acrobat you are using.

I & 5 | AcrobatPitStopTools-master = [m} X
Home Share View v o
€ v A4 | C:\Users\IPAC_PC1\Documents\JACoW Editor\AcrobatPitStopTools-master| v o O Search AcrobatPitStopTools-master
~
Name Date modified Type Size
s Quick access
IPAC JACoW Font 5/21/2022 5:00 PM File folder
[ Desktop »
Notuse 5/21/2022 5:00 PM File folder
¥ Downloads  # % JACOW Media Box 019 9:34 PM Enfocus Action List 5KB
[5 Documents  # & jacow-09 9/4/2019 9:34 PM Adobe PDF Settings 14KB
Pictures * ’ JACoW-10 9/4/2019 9:34 PM Adobe PDF Settings 14KB
Ad JACoWSetDot 9/4/2019 9:34 PM JavaScript File 10KB

9/4/2019 9:34 PM File 3KB

AcrobatPitStopTool [ reapmEe

AcrobatPitstopTool Script for Acrobat_Pitstop_PowerPoint Re... 2 11:02 AM Adobe Acrobat D... 35KB
[c]:] SplitAnimations 9/4/2019 9:34 PM Microsoft PowerP... 32KB
IPAC 22 IT Work
| @ SplitAnimations 9/4/2019 9:34 PM Microsoft PowerP... 545 KB
[#%] OneDrive
@ OneDrive
3 This PC
¥ Network

10items  1item selected 9.98 KB

Copy to local temp directory first

C:\Program Files\Adobe\Acrobat DC\Acrobat\Javascripts

< | Javascripts - o X
Home Share View o
€ i <« Windows (C:) > Program Files > Adobe > AcrobatDC > Acrobat > Javascripts v O O Search Javascripts |
Name Date modified Type Size
s Quick access
B Desktop . debugger 2/1/2021 9:49 PM JavaScrfp! F!Ie 24KB
@ EnfocusSupport 32 1:47 AM JavaScript File 3KB
¥ Downloads  # [] JsByteCodeWin.bin 2 2:01 PM BIN File 3,513KB
) Documents  #
& Pictures -
10.Adobe Acrobat F
AcrobatPitStopTool
View >
IPAC 22 1T Work
Sort by >
IPAC22_Software
Group by >
@ OneDrive Refresh
3 ThisPC Customize this folder...
= PAC Software (E) Paste [y
Paste shortcut
¥ Network Undo Copy Ctrl+Z
Give access to >
New >
Properties
3items
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Distiller Configuration
This will explain who to add the JACoW-12 options to the distiller etc.

Recently added

D] CamStudio

\/@ VNC Viewer
W Zoom

Expand v

#

@ 3D Viewer
B

Access

Adobe Acrobat DC

Adobe Acrobat Distiller DC

Alarms & Clock

B Acrobat Distiller - O X
File Settings Help
Adi Font Locations... Ctrl+L
Watched Folders... Ctrl+F il
) Edit Adobe PDF Settings... Ctrl+E eliable
v Add Adobe PDF Settings... Ctrl+Shift+E  Iments can
Remove Adobe PDF Settings... Ctrl+R
Prc Security... Ctrl+S
Status® Ready
|
Pause | nce |

PDFFle | Size | Time | PSFile

| Size | [3 Settings | PDF Fold

< >
Calculator
/Osaka-MonoRoman A
Calendar /QOsaka-PropRoman
/RLKL-PropRoman
Mcmers /Ryumin-Light-KL-PropRoman
/SMFix|
CamStudio 2.7
i v
" mo
B Add Adobe PDF Settings X
M & » ThisPC > Documents v O Search Documents »r
Organize v New folder =~ M @
& OneDrive () Name Date modified Type Size
I This PC Custom Office Templates 4/25/2018 5:53 PM File folder
3 3D Objects
[ Desktop
| Documents
‘ Downloads
D Music
&=/ Pictures
B videos

= PC19(\\172.21.3
‘i Windows (C:)
s USB Drive (E})
pub (\172.21.32

H

s USB Drive (E) v

File name: | FECEEE

vl Adobe PDF Settings Files (*,jobr v

19| Page




&

<« t » ThisPC > Documents > JACoW Editor » AcrobatPitStopTools-master v V] Is
Organize v New folder - ™ @
A Name Date modified Type Size
s Quick access
IPAC JACoW Font 3 e
[ Desktop .
Notuse 5/21 P File folde
¥ Downloacs JACOW-12 11/16/20239:34 PM Adobe PDF Settings 14K8
9
%) Documents
& Pictures
A4
AcrobatPitStopT
AcrobatPitStopT
IPAC 22 IT Work
[#:] OneDrive
@ OneDrive
[ This PC
% Network o
File name: | JACOW-12 | | Adobe PDF Settings Files (*.job: -
Open Cancel
& Acrobat Distiller - O = B Acrobat Distiller - [m] X
File Settings Help ‘I File Settings Help
— Adobe PDF Settings Open... Ctrl+0 |
Defaut Settngs: -
o Preferences... Ctrl+K
Compatibilty:  Acrobat 7.0 (PDF 1.6) F 1.6)
Setup for JACoW - paper size. embed all fonts. compression. Acrobat 7 Exit Ctrl+Q bed all fonts, compression, Acrobat 7
compatibility ¥
r— Progress r~ Progress
Status: Ready Status: Ready
Pause | LCancel Job | Pause
PDFFile | Size | Time | PS File Size Settings | PDF Fold PDFFie | Size | Time | PS File Size Settings | PDF Fold
el
=
< > < >
/Osaka-MonoRoman ~ ﬁggaﬁ:tlr\d%mnol?oman o
/Osaka-PropRoman /Osaka-PropRoman
J’:E}I“L(LTPEDE"EES A /RLKL-PropRoman
min-Light-KL-PropRoman ot K]
S MFix /Ryumin-Light-KL-PropRoman
~ v

Preferences - Acrobat Distiller

r~ Startup Alerts
¥ Notify when Watched Folders are unavailable
¥ Notify when Windows TEMP folder is nearty full

—~Output Options Help
[V Ask for PDF file destination
[V sk to replace esisting PDF file

[V View PDF when using Distiller

rLog Files
[V Delete Log Files for successful jobs

r— Security
[ Trust allfiles opened via Acrobat Distiller

These preferences control the Distiller application. For Adobe PDF
Printer settings, rightclick the Adobe PDF printer and choose Printing
Preferences or Document Defaults.

o

EE
&X
x| N
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Adobe Printing Configuration
Access the Control Panel\All Control Panel Items\Devices and Printers and Right click the Adobe PDF
> Printing Preference

kﬁh Adobe PDF

Manage your device

Printer status:  Default

Open print queue Set as default

Print a test page
@ Adobe PDF Printing Preferences
Run the troubleshooter
Layout Paper/Quaiity Bl Adobe PDF Setings
Adobe PDF Conversion Settings

Setup for JACOW - paper size, embed all fonts, compression, Acrobat 7 compatibility.

Printer properties

Printing preferences

Hardware properties
PP Defautt Setiings: [JACOW-12 ] Edit..
Adobe PDF Securiy: |[None ~| Edit
Adobe PDF Output Folder [Promptfor Adobe PDF filename =] [T Browses.

Adobe PDF Page Size: [A4 ~] Add...
] View Adobe PDF results
[ Add documentinformation
e ] Rely on system fonts only; do not use document fonts

] Delete log files for successful jobs

] Ask to replace existing PDF file
OK Cancel Apply
@ Adobe PDF
Manage your device
Printer status:  Default
Open print queue Set as default
Print a test page
-y
Run the troubleshooter
Layout Paper/Quaity [Jll Adobe POF Setings
Printer properties Tray Selection
Paper Source: |Automatically Select
Printing preferences
. Colour
Hardware properties
E‘ Black & Whit a ® Colour
Adobe PDF Converter Advanced Options X
= Adobe PDF Converter Advanced Document Settings
Paper/Output
Paper Size: ¥} . POpEr SI2€ dO€sn't matter as it
Copy Count: 1 Copy is set above in Paper Source as
N Graphic
Print Quality: 1200dpi Automatically Select

© Inage Colour Management
ICH Method: ICM Disabled
ICH Intent: Pictures Advanced...
Scaling: 100 %
TrueType Font: Download as SOftfON! ue——
# Document Options
.Pu%ripl Options oK Cancel Apply
PN Script Output Option: Optimize for Portability

TrueType Font Download Option: Native TrueType
PostScript Language Level: 3
Send PostScript Error Handler: Yes

Mirrored Output: No o

cmc
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Word 365 Configuration

Acrobat 2017 Setup - Word E x
® -
e Info
New

Acrobat 2017 Setup
Open Z: Docs » Setups
Save Protect Document Properties =
Control what types of changes people can make to this document Sze 183M8

Words El

Save as Adobe
TotalEditing Time 206 Minutes
Title Add atitle

sy Inspect Document o Yo
G LW G e e i e
Shre Checkfor Document properties, author's name and cropped out image data omments fadcomment
. fses Footers
Characters formatted as hidden text e e

Export Custom XML data LastModified  Today, 11:53AM

Cose Content that people with disabilties are unable to read Created Today, 309 AM
Last Printed

Manage Document 2 .
Account Checkin, check out, and recover unsaved changes. R
Manage ) There are no unsaved changes. Author
Options Document+ | 0 ™ e chang Windows User

Add an author

Last Modified By
Windows User

Related Documents

Open File Location

Show All Properties

Word Options ? X
¥ UPaTE aocURTEnT CoRTEnT WHITE araggimng = N
General X .
| Use subpixel positicning to smooth fonts on screen
Display
X Print
Proofing
Save Use draft guality
| Print in background G
Language ) )
Print pages in reverse order
Advanced Print XML tags
Customize Ribbon Print field codes instead of their values
Quick Access Toolbar | Allow fields containing tracked changes to update before printing
Print on front of the sheet for duplex printing
Add-ins . -
Printon b or duplex printing
Trust Center [T Scale content for Ad or 8.5 x 11" paper sizes
Default tray: | Use printer settings -
When printing this document: s Acrobat 2017 Setup v
Print PostScript over text
Print only the data from a form
Save
Prompt before saving Normal template G
Always create backup copy
Copy remotely stored files onto your computer, and update the remote file when saving
v| Allow background saves
Preserve fidelity when sharing this document: Wi Acrobat 2017 Setup +
Save form data as delimited text file
| Embed linauistic data -
OK Cancel
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Keyboard shortcuts:

Word Options ? X
G | .
Sner E-E Customize the Ribbon and keyboard shortcuts.
Display
Lhoose commands from:(2 Customize the Ribbon: (&
Proof
roeting | Popular Commands = Main Tabs =4
Save
Language Accept Revision [+] in Tabs []
E Add Table ’ Home
Advanced = Align Left Insert
Bullets 4
(Customize Ribbon_> Center EES‘Q"
— ayout
. & Ch List Level 4
Quick Access Toolbar Egy CU:;ge ke Ref.erences
Add-ins X Cut Mailings
Define Mew Mumber Format...
Trust Center ﬁj Delete
m Draw Table
Draw Vertical Text Box
107 Email L
AL Find El
B} Fit to Window Width
Font Ir El
A Font Color |’
A Font Settings AdJ;mplates
Font Size Ihd ns
InB* Footnote ACROBAT
Format Painter Blog Post
A Grow Font Insert (Blog Post)
Hyperlink.. Qutlining
L‘:I Insert Comment Background Remowal =]
= Insert Page Section Breaks 4 g
o Insert Picture Mew Tab | | New Group | | Rename... |
Insert Text Box -
—

Customizations:

Now will have Development Tab on the Ribbon.

B oS-

File Home Insert

References

View

Acrobat 2017 Setup Under [}

ACROBAT

Design Layout

Mailings

Developer Q Tell me

Ll D 9 Record Macro a ﬁﬂ- Aa fa (= E5 ,l,‘._{,’Dswgn Mode @ D
B
X LS Il® Pause Recording o m EE B Properties i X
Visual Macros Add-  Word COM _ — XML Mapping Block Restrict |Document
Basic ! Macro Security ins  Add-ins Add-ins L_‘ﬂ =i -2 Group Pane Authors - Editing | Template
Code Add-ins Controls Mapping Protect Templates
L 1 .5.1. e | DA B B
Templates and Add-ins ? *
Templates XML Schema XML Expansion Packs  Linked C55

Document template

| Maormal

D Automatically update document styles

Attach to all new e-mail messages

Global templates and add-ins

Checked items are currently loaded.

Full path:

ok | cancel
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From https://github.com/JACoW-org/JACoW_Templates/tree/master/MSWord/A4

[ Attach Template X
« v + ThisPC # Desktop » Editor » v |0 Search Editor 2
Organize * Mew folder B=~ [ o

Name - Date modified Type Size

[E| Microsoft Word

Thursda 4/27/2018 9:06 AM File folder
¢@ OneDrive
-] JACOW_W16_A4 4/26/20185:58PM  Microsoft Word T.. 6,062 KB

& This PC
2} 30 Objects
B Desktop
Documents
; Downloads
b Music
[&=] Pictures
m Videos
= PC19 (\\172.21.3
e Windows (C:)
= pub (\\172.21.32

=% Network v
File name: | JACOW_W16_A4 v| |l Word Templates v
Tools | Open | ‘ Cancel |
Word Options ? N
General ; =
Customize how documents are saved.
Display
Proofing Save documents
Save Save files in this format: \ Word Document (*.docx) '
Language Save AutoRecover information every | 5 C| minutes
Accessibility [7] Keep the last AutoRecovered version if | close without saving
Advanced AutoRecover file location: lC:\Users\IPAC_PC NAppData\Roaming\Microsoft\Word\ Browse...

Customize Ribbon [[] Don't show the Backstage when opening or saving files with keyboard shortcuts

[¥] Show additional places for saving, even if sign-in may be required.

Quick Access Toolbar [] save to Computer by default

Add-ins

Default local file location: C:\Users\IPAC_PC1\Documents\ Browse...

[
i

Trust Center Default personal templates location:

Offline editing options for document management server files

Saving checked out files to server drafts is no longer supported. Checked out files are now saved to the Office
Document Cache.

Leam more
Server drafts location: |C:\Users\IPAC_PC1\Documents\SharePoint Drafts\

e fidelity when sharing this document: [ @ All New Documel <

[ Embed fonts in the file ()
HSJEmbed only the characters used in the document (best for reducing file size)l

[] Do not embed common system fonts

Days to keep files in the Office Document Cache: | 14 v

I oK Il Cancel |:
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1. Enable editing in word by default

Access the menu File > Option > Trust Center > File Block Setting to check”Open selected file types
in Protected View and allow editing” then click “OK”

Open behavior for selected file types:
Do not open selected file types

Open selected file types in Protected View

© [Open selected file types in Protected View and allow editing|

i, General
D Help keep your documents safe and your computer secure and healthy. S
Paste Display Request ft 365
¥ Proofing Security & more Pignatures
Clipboard bat A~
Save Visit Office.com to learn more about protecting your privacy and security. 6. . -1 |nvite
Navig | tangusge Microsoft Trust Center hft 36
Search{ | Accessibility
Microsoft Word Trust Center
Advanced ETO OUR
Heading| The Trust Center contains security and privacy settings. These settings help keep your -
Customize Ribbon computer secure. We recommend that you do not change these settings. Trust Center Settings
Quick Access Toolbar
In Trust Center ? X
Gd| Add-ins
sted Publishers
da | Trust Center Insted Rublihen File Block Settings
A Trusted Locations
i For each file type, you can select the Open and Save check boxes. By selecting Open, Word blocks this file type, or
Trusted Documents opens it in Protected View. By selecting Save, Word prevents saving in this file type.
P Y 9 P! 9 yP
C il [y "
Trusted Add-in Catalogs File Type Open _JSave
A Word 2007 and later Documents and Templates ] ]
R Addains OpenDocument Text Files O O
ActiveX Settings Word 2007 and later Binary Documents and Templates [} O
Macro Settings Word 2003 Binary Documents and Templates O
Word 2003 and Plain XML Documents O O
Protected View )
Word XP Binary Documents and Templates O
M ge Bar Word 2000 Binary Documents and Templates O
File Block Settings Word 97 Binary Documents and Templates O
Privacy Options Word 95 Binary Documents and Templates (iJ
Word 6.0 Binary Documents and Templates ™)
Form-based Sign-in Word 2 and earlier Binary Documents and Templates
Web Pages O O
RTF Files O O
Page 1 of SI7WOras — [jF  ENgISNA Plain Text Files O O
Legacy Converters for Word O O
Office Open XML Converters for Word O |
PDF Files O

estore Defaults

25| Page



PowerPoint 365 Configuration

Presentationl - PowerPoint signin & ? . a] X
Good evening
~ New
[ New
7 Open - Title Lorem
¥ Ipsum
Info g
Blank Presentation ‘Welcome to PowerPoint Bring your presentations to ... Pantone Color of the Year 20... Geometric color block Urban monochrome
Save
Save As More themes —>
Save as Adobe
PDF Recent  Pinned
You haven't opened any presentations recently. Click Open to browse for a presentation.
More presentations —>
Account
G
PowerPoint Options ? X
G | X : = 5
cpere D} View and manage Microsoft Office Add-ins.
Proofing
Save Add-ins
Language | Name ~ | Location | Type
Accessibility ‘Active Application Add-ins
Acrobat PDFMaker Office COM Addin C:\...Maker\Office\x64\PDFMOfficeAddin.dll COM Add-in
Advanced Foxit PDF Creator COM Add-in C:\...gins\Creator\x64\FPC_PPTAddin_x64.dll COM Add-in
: PPsphiT CA\...Microsoft\AddIns\PPspliT\PPspliT.ppam PowerPoint Add-in
Customize Ribbon
WSS Toolbar Inactive Application Add-ins
OneNote Notes about PowerPoint Presentations  C:\...ft Office\root\Office16\ONPPTAddin.dll COM Add-in
(‘Addins )
M Document Related Add-ins
No Document Related Add-ins
Disabled Application Add-ins
No Disabled Application Add-ins
Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Inc.
Compatibility: No compatibility information available
C:\Program Files\Adobe\Acrobat DC\PDFMaker\Office\x64\PDFMOfficeAddin.dll
Acrobat PDFMaker Office COM Addin
Go..
> I OK I { Cancel |
Disabled Items
ility: Good to go = Notes #8 Comments =N S
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Add-ins

Available Add-ins:

Load
[ pespiit

@ Add New PowerPoint Add-in

< v A | | > IPAC Software (E:) » IPAC22ITWogk > AcrobatPitStopTools-master >
Organize v New folder
P
A Name Date modified
3 Quick access

[ Desktop »*
& Downloads #

=| Documents

% 5/10/2022 11:14 AM
@} SplitAnimations 9/4/2019 9:34 PM

[&] Pictures S g
10.Adobe Acrob
AcrobatPitStopT

. IPAC 22 IT Work

| IPAC22_Software

@ Microsoft PowerP
@ OneDrive

This PC

— IPAC Software (E) ¥

File name: | SplitAnimations

Type

File folder

Microsoft PowerP...

X

o O Search AcrobatPitStopTools-...

By @ @

Size

32 K8

N

s vl

@N’K | [ Onca |
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Microsoft PowerPoint Security Notice ? X

@ Microsoft Office has identified a potential security concern.

Warning: It is not possible to determine that this content came from
a trustworthy source. You should leave this content disabled unless
the content provides critical functionality and you trust its source.

File Path: | E:\IPAC 22 IT Work\AcrobatPitStopT ools-master
\SplitAnimations.ppa

Macros have been disabled. Macros might contain malware or other
security hazards. Do not enable this content unless you trust the
source of this file,

More information

| Enable Macros DLgisable Macros I

Add-ins ? X

Available Add-ins:

I Load |

d [ pespiit / e

| Add New... |

Remove |
N _glose D

Enfocus PitStop 21.3.0 Activation Process

Select the menu Help > About Third-Party Plug-Ins > About Enfocus PitStop Pro.
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Adobe Acrobat Pro DC (64-bit) - [m] X
File Edit View E-Sign Certifid POF PitStopPro Window Pitstop Pro Dash
Home  Tools | @ Sign In
| ~
Recent
Recommended tools foryou| "%~ Help ’ See All Tools X
Starred [T Get documents signed fast
Adobe Acrobat Pro DC 2
. o Get documents signed in minu
52 kditPoF _ hbine Files N 9
DOCUMENT CLOUD ATTTGT Adobe Plug-Tm usted e-signatures.
Edit text and images fast. Fix a o =
R—— W50 o7 Giog 4n BTage About Third-Party Plug-Ins > Ciiil Damres
Use Sign In/Sign Out T TTeCk..
Scans 5 & ; ‘
Shared by you Generate System Report
Recent Repair Installation H]
Shared by others
- Check for Updates... b ZE
OTHER STORAGE
Script for Acrobat_Pitstop_PowerPoint Readme a ;
Today, 5:54 P 35 KB
My Computer POF
Add an Account jacow-collaboration = S
PDF - ou o 5:3
SIGN
All Agreemei
Changelog = S 5 KB
0 Today, 5:34 P B
POF
= Processing transparencies - a step-by-step guide - ’ S S
= POF - N
- document . = s -
= PDF - N h -
Editor Copmputer Setup = = z %
Clear Recent

Select “Offline Activation”

About License Support info

Preflight your way
If you don't have internet access, you can continue with offline activation.

If you have a subsaription, please go online and you will see a sign in sareen appearing. Sign in with your
Enfocus ID to start your subscription.

Try Again Edit Proxy Settings... Offline Activation

Contact a System Administrator to edit
your Proxy Settings.

PITSTOP

PRO
2022

Start Trie Buy/Subscribe...

ENFOCUS

1 should be online again by now, try again

Close
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Click “Start Trial.”

About Enfocus PitStop Pro

About License Support info

Preflight your way

Offline activation mode: In case you would lke to start a subscription, this will not work.

Start Trial Activate Key

PITSTOP

PRO
2022

ENFOCUS

1 should be onliine again by now, try again

Enter the Enfocus ID then click “Start Trial.”

About Enfocus PitStop Pro
About License Support info

Preﬂlghty our way Enter your Enfocus ID to start your trial

Enfocus ID: (|chytpreecha. 2124@gmail.com 3 ]

PITSTOP

PRO
2022

ENFOCUS
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Save the Request Activate file to computer.
Q Acrobat

Step 1: Create Activation Request

Please save or drag and drop this activation request and upload it to the Enfocus

Step 2: Load Activation Response

Please load, or drag and drop the activation response into this panel.
activation website on a computer that has an internet connection.

http: /fwww.enfocus.com/products/activationlang=enUS

This is the file you received from the Enfocus activation website during Step 1.

You will receive an activation response which you should load in the right-hand

panel; Step 2
Then dick Activate to complete the activation process.
_L\
‘— o )
i
[ |
I |
i l
N s e s o
requestactivate.xml
Load...
Actvate | [ cancel
c Acrobat 2 % [ @_L
Save File X

A [§ > ThisPC > Documents >

Organize v New folder
-~
X Name Date modified
s Quick access
B Desk » . download_wmm 5/11/2022 1:34 PM
eskto)

’ oftMaker 5/10/2022 1:23 PM
¥ Downloags™ # | ] requestactivate 5/11/2022 4:41 PM
[£ Doc t
l=| Pictures *

. 10.Adobe Acrob
IPAC 22 IT Work
IPAC22_Software
D Music
@ OneDrive
This PC
v

v 0 O Search Documents
=~y @
Type Size
File folder
File folder
XML Document 3KB|

File name: | requestactivate

Save as type: | Request Files (*xml )

A Hide Folders
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Click a link to offline activation webpage. Then Browse to activate request file at local folder.

Q’ Acrobat
Step 1: Create Activation Request Step 2: Load Activation Response

Please save or drag and drop this activation request and upload it to the Enfocus
activation website on a computer that has an internet connection.

ttp://www.mfocus.corn/p(oducts@wabon@

You will receive an activation response which you should load in the right-hand
panel: Step 2

Please load, or drag and drop the activation response into this panel.

This is the file you received from the Enfocus activation website during Step 1.

Then dick Activate to complete the activation process.

N\
N
B
= P gy,
e
requestactivate,
| Load
Activate Cancel
@ Offline activation | Enfocus X | + = (m]

@ O a https://www.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS bk

Home > Support > Licefising & activation > Offline actvatior
@ File Upload X
Offline gctiv o[ mwre s v s ool [P
Here you can ugjfad the request{ Organize ¥ New folder =y @ @
A Name Date modified Type Size
7 Quick access
emte atesnanse file download_wmm 5/11/2022 1:34 PM File folder
- Bl Desktop * 2
\ oftiaker 5/10/2022 1:23 PM File folder
Browse... | No file selected. it W 5/11/2022 4:46 PM XML Document 3Ke
[£ Documents # Ls

N

:

[&) Pictures »
10.Adobe Acrob
IPAC 22 1T Work
IPAC22_Software
D Music

@ OneDrive
I This PC
s IPAC Software (E:)

o Network 57

File name: | requestactivate
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Enter Enfocus E-mail and Password that was registered.

@ Offline activation | Enfocus X +

< C @ O 8 o htps

v.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS Q O =
ENF@CUS

Home > Support > Licensing & activation > Offline activatior
Offline activation

E-mail chaypreecha.2124@gmail cc

Password [ ecccccce

Forgot your Password? j
| Continue ’

Then click “Continue” to activate program.

ENF@CUS

Home > Support > Licensing & activation > O

Offline activation

The activation request you submitted is for the following product.

PitStop Pro 2022 (Trial) [N
PPRsg2-YATAAS-1aDGgl-BANQu9-7b8c3C

If this is the product you wish to activate, click Continue.
If this is not the product you wish to activate, click Previous and upload an other activation request file.

Previous | Continue .
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After registering, download the registration file.

@ Offline activation | Enfocus X = + - B %
&« C @ O 8 https://www.enfocus.com/en/support/licensing-and-activation/offline-activation?lang=enUS ww .‘l’a =

D activation-responsexml
Completed — 5.3 KB

ENF@CUS

Home > Support > Licensing &activation > Offiine actvatior Show all downloads

Offline activation

You have now leted the y steps for uploading the activation request file.

To finalize the activation, you need to load the file you d ded from this page in the Activate License Wizard. This will activate your license.
Return to the activation options

PPRsg2-YATAAS-1aDGgl-BANQu9-7b8c3C
PitStop Pro 2022 (Trial)

Load Activation Response file.
# Acrobat ? X

Step 1: Create Activation Request Step 2: Load Activation Response

Please save or drag and drop this activation request and upload it to the Enfocus Please load, or drag and drop the activation response into this panel.
activation website on a computer that has an internet connection.

A/ At epiacus conixocucs/activaliopieng SIS This is the file you received from the Enfocus activation website during Step 1.

You will receive an activation response which you should load in the right-hand
panel: Step 2
Then dick Activate to complete the activation process.

A

N\ s e

o o o

requestactivate.xml

Activate Cancel
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t Acrobat

? X l
@
Open File X
4 [& > ThisPC > Documents » v 0 O Search Documents
Organize v New folder E:v @ o
o Name Date modified Type Size
A Quick access
. download_wmm 5/11/2022 1:34 PM File folder
[ Desktop »

SoftMa

5/10/2022 1:23 PM File folder
» 5/11/2022 451 PM XML Document

6KB|
5/11/2022 4:50 PM XML Document 3KB
[&=]| Pictures *

‘ Downloads

&

%] Documents

. 10.Adobe Acrob
| | IPAC 22 IT Work

IPAC22_Software
D Music

@ OneDrive
This PC
= IPAC Software (E:)

= Network ¥

File name: | activation-response

\j | Response Files (*.xml)

I Open l ) Cancel

2
|.
%

[Activate | | cancd |
% Acrobat ? X
Step 1: Create Activation Request Step 2: Load Activation Response

Please save or drag and drop this activation request and upload it to the Enfocus Please load, or drag and drop the activation response into this panel.

activation website on a computer that has an internet connection.

hitp://www.enfocus.com/products/activation#iang=enUS This is the file you received from the Enfocus activation website during Step 1.

You will receive an activation response which you should load in the right-hand Then dick Activate to complete the activation process.

panel: Step 2

requestactivate.xml =
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Finish.

About Enfocus PitStop Pro
About License Support info
Preflight your way

If you don't have internet access, you can continue with offline activation.

If you have & subsaiption, please go online and you will see a sign in screen appearing. Sign in with your
Enfocus ID to start your subscription.

Try Again Edit Proxy Settings... Offline Activation

Contact a System Administrator to edit
your Proxy Settings.

PITSTOP

PRO
2022

You can now use Enfocus PitStop Pro for . ] Buy/Subscribe
31days alald.

ENFOCUS

1 should be onine again by now, try aqain
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Load Enfocus PitStop JACoW Media Box
Select menu PitStop Pro > Action Lists.

[ IPAC19ITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) = o X
File Edit View E-Sign Certified PDI indow PitStop Pro Dashboard Help
Home  Tools IPAC19I Object » @ A Signin
Prefiight Alt+Ctri+P
By ® 8 Q H e
& Global Changes Alt+Ctri+G —
Alt+Ctri+A Al a
QuickRuns
QuickRun Favorites Eb
Na\‘/igator... Eﬁ
Object Browser...
Variable Sets L E
Typical daily bandwidth .
P y P
= 0
E G
| S <
: =
G =
%
Select menu Local > Import/Export > Import
[® IPACTSITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) - o ¥
File Edit View E-Sign Certified PDF PitStop Pro Window PitStop Pro Dashboard Help
Home  Tools IPAC19ITSetupRep... % @ A signin
BX®B QOO z2/=| MO nx- B P oo a =B e

Action Lists

FMeEF

Favorites
Recent
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Locate file and click “Open.”

® 1PAC19ITSetupReport paf - Adobe Acrobat Pro DC (64-bit) - 0 X [
File Edit View E-Sign Certified PDF PitStopPro Window PitStop ProDashboard Help
Home  Tools IPAC19ITSetupRep... % @ A signin
AcrobatPitStopTools-master > R
N, &2
BY¥®8 Q0@ 7/ MM OO® - @ F oo a X e
! Date modified Type Size

A @ | 502022 1114 am File folder
Action Lists 9/4/20199:34PM Enfocus Action List 5KB
B 9/4/20199:34PM Adobe PDF Settings 14K8
(]
9/4/2019 9:34PM Adobe PDF Settings 14K8
BN | owamosaurm JavaScript File 10K8
9/4/2019.9:34PM File 3K8
o= | 5/9/202211:02 AM Adobe Acrobat D... 35K8
B2 | gu2019934pM Microsoft PowerP... 32K8
| L | ompovsssem Microsoft PowerP. 545 K8
Typical daily k R
YP y €« « 4 |1 CPAC Software (E) > IPAC 22 ITWork > Ambmpits@ v & | O SearchAcrobatPitstopTools-...
Organize v New folder m @
A Name ] Date modified Tpe Size
A Quick access
Woiws  # m 5/10/2022 11:14 AM File folder -
JAGOW Media Box 9/4/2019 9:34PM Enfocus Action List 5K8
& Downloads # . s
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[ ] 1PAC22_Software
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File name: [JACOW Media Box <] [Enfocus Action Lists (nea) |
Open Cancel
Finish.
= PAC19ITSetupReport.pdf - Adobe Acrobat Pro DC (64-bit) — [m] X
File Edit View E-Sign Certified PDF PitStop Pro Window PitStop Pro Dashboard Help
Home  Tools IPAC19ITSetupRep... X @ A signin
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MikTex Console Configuration

. K-Lite Lodec Pack
le

Productivity
L

B LbreOffice 7.3 ~ $

M
Microsoft Edge Firefox
M Mail
® Maps
MaxxAudioPro

] Microsoft Edge

- Microsoft Office Tools

u Microsoft Store

Microsoft Teams VQ

New

A VNC Viewer
Bl vikrex

'ﬁ’ MiKTeX Console

a TeXworks

& \ixed Reality Portal 5(

ey Double
P Movies & TV Commander

N

B Notepad++
)P ® v m ©

MiKTeX to be installed in "User mode" (not “Admin mode”) because "Admin Mode" leads to
package load errors and a mix-up when users are not logged in as Administrators and the flag on

“Always” is not set correctly (which requires Admin privs when installing).

£ MiKTeX Console

File Tasks Help

Welcome!

This is MiKTeX Console. The program will assist you in managing your MiKTeX configuration.

If you want, you can start with an online tutorial: HOWTO: manage MiKTeX with the MiKTeX Console

Operation mode

Please decide how you wish to continue:

—> Switch to MiKTeX administrator mode

Use this option, if you want to operate on the shared (system-wide) MiKTeX configuration.

J — Stay in MiKTeX user mode
5 Continue to work with MiKTeX Console in MiKTeX user mode.
Use this option, if you want to operate on your own MiKTeX configuration.

Check for updates

Restart MiKTeX Console with elevated privileges and switch to MiKTeX administrator mode.
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Select “Settings”

@ NiKTeX Console - m] X
File Tasks Help

Settings
Overview
General Directories Formats Languages

Updates

User interface

Documentation

Language: <System Language> ~
Packages

Package installation
Diagnose

Packages are retrieved from: <Random package repository on the Internet> -~ Change...
Ll You can choose whether missing packages are to be installed automatically (on-the-fly):
Settings ® Always =

For anyone who uses this computer (all users)

O Ask me

'y O Never
Paper format

Select your preferred paper format: A4

A
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Enable the built-in PDF viewer

You can also set a PDF viewer to handle PDF files. To switch from using another viewer to the built-in

PDF viewer:

PwnNPE

Click the menu button =and select Settings.

In the General panel, go down to the Applications section.

Find Portable Document Format (PDF) in the list and click on the entry to select it.
Click on the arrow under the Action column for the above entry and select the Open in

Firefox from the drop-down menu.

@ Settings

C (@ @ Firefox

@3 General
@ Home
Q Search

& Privacy & Security
Q Sync

m More from Mozilla

i] Extensions & Themes

@ Firefox Support

Other References

e https://www.jacow.org/

X

+ =

about:preferences w

’ Find in Settings ‘

Applications

Choose how Firefox handles the files you download from the web or the applications you use while

browsing.

O Search file types or applications

Content Type - | Action
& AV1 Image File (AVIF) @ Openin Firefox
[ Extensible Markup Language (XML) % Save File

mailto [T Use Mail (default)

Portable Document Format (PDF) “Y Open in Firefox

A

@€ Scalable Vector Graphics (SVG)
€ WebP Image

» Open in Firefox

2 Always ask

% SaveFile
[] Use Windows default application

Use other...

e https://www.jacow.org/Editors/AllThingsIT

e https://www.jacow.org/Editors/RecommendedSoftware
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